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ABSTRACT 

This project report on As-built survey of Kwara Polytechnic, Ilorin mini campus, the project was aimed at 

producing an As-built survey plan of the polytechnic, this aim and the objectives were achieved  through 

the following scopes, recce survey, project planning, data acquisition, data processing and report writing. 

The methodology employed includes preliminary reconnaissance, checking of control points using Total 

station, data collection with a Total Station, and data processing was done using autoCAD2007 and the 

information presentation in both hard and soft copies. The acquired data were processed and analyzed 

to generate an as-built  plan that aligns with planning standards and legal requirements for building and 

academic construction standard. 
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CHAPTER ONE 

1.0  Introduction 

An As-Built Survey refers to the precise documentation of a construction project 

as it was actually completed, rather than how it was initially designed. This survey 

captures all physical and structural changes that occurred during construction, including 

modifications, deviations from the original plan, and unforeseen adjustments. These 

records are essential not only for validating the completion of a project but also for 

ensuring that all components comply with regulatory standards and design intentions. 

Without accurate as-built documentation, future maintenance, renovations, or legal 

verifications can be hindered due to discrepancies between the planned and constructed 

environments (Barazzetti et al., 2015). 

Modern technologies such as 3D laser scanning, photogrammetry, and Building 

Information Modeling (BIM) offer more precise and efficient means of conducting as-

built surveys, their adoption remains limited, particularly in small and medium-sized 
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construction firms or in developing regions. Barriers such as high implementation costs, 

insufficient training, and poor integration into existing workflows prevent many 

stakeholders from leveraging these tools. As a result, there is a growing need to examine 

the shortcomings of current as-built survey practices and to identify feasible strategies for 

improving accuracy, efficiency, and accessibility through digital innovation. 

The importance of as-built surveys has grown significantly with the advancement 

of digital surveying technologies. Traditional manual methods, while still in use, are 

increasingly being supplemented or replaced by high-precision tools such as 3D laser 

scanning, photogrammetry, and drone mapping. These technologies offer efficient, non-

invasive, and highly accurate methods of capturing the real-world conditions of 

completed structures (Tang et al., 2010). By creating detailed 3D models and point 

clouds, surveyors can identify even the smallest discrepancies between design 

specifications and actual construction, improving project quality and minimizing risks. 

The critical role that As-Built Surveys play in accurately documenting completed 

construction projects, many developments suffer from discrepancies between the original 

design and the final construction due to inadequate or outdated surveying methods. 

Traditional techniques—often manual and time-intensive—struggle to capture complex 

changes that occur during the construction phase, leading to incomplete or inaccurate 

records. These gaps not only hinder future renovations and facility maintenance but can 

also result in regulatory non-compliance, legal disputes, and increased operational costs. 

The lack of reliable as-built data ultimately compromises the long-term value and safety 

of built infrastructure. 



 39 

1.1  Statement of Problem 

In many construction projects, discrepancies often arise between the original 

design and the actual construction. This can lead to future design challenges, legal issues, 

or costly alterations. Lack of accurate and up-to-date records of existing conditions can 

also hinder maintenance, expansion, or demolition works. Therefore, there is a need for a 

reliable method to capture and document existing structures precisely as they are built, 

especially for academic institutions like the project area. 

1.2  Aim of the Project 

The aim of this project is to conduct an accurate as-built survey of an existing 

structure or infrastructure to provide detailed, verifiable documentation of its actual 

conditions upon completion, specifically for the project area. 

1.3  Objective of the Project  

i. To identify and record deviations from original design plans. 

ii. To produce precise drawings that represents the existing physical state of the project. 

iii. To produce a record surveying plan of the under-construction structure using the total 

station. 

iv. To enhance understanding and application of geospatial techniques in post-construction 

documentation. 

1.4  Scopes of the Project 

This project focuses on conducting an as-built survey for a selected site, including 

the collection of field data, data processing, and generation of final as-built drawings. It 
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covers planimetric and elevation features but excludes sub-surface or utility surveys 

Successful execution of this project involved the following scopes: 

i. Project planning. 

ii. Field reconnaissance. 

iii. Data acquisition. 

iv. Data processing. 

v. Information presentation. 

vi. Technical report writing 

1.5  Project Specifications 

 The specifications on this project involve the rules and regulations guiding the 

practice and processes of surveying, which are: 

i. Connection of the survey to national framework (control pillars). 

ii. A close traverse must be laid out for the perimeter survey to ensure checking on the final 

survey work. 

iii. Provision of the back computation sheet to show the list of the coordinates used for the 

perimeter survey. 

iv. Linear accuracy of the survey work must be done accurately. 

v. The plan to be produced must be a signed using standard as-built plan scales. 
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1.6  Project Location Description 

The project site is located along Kwara state polytechnic Mini-Campus, inside 

university of Ilorin Mini-Campus, Off General Gari Alimi road, Ilorin-west local 

Government Area of Kwara State. Approximately the site is located on latitude  

8°28'53.20"N ; longitude  4°31'37.75"E and 8°28'55.41"N; 4°31'30.28"E and the imagery 

below show the project area. 
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1.7  Personnel Involved 

The following are the members of the group that was involved in the as built 

survey project work, they are; 

S/N Names Matric No Role  

1. Ilori Waris Opeyemi  ND/22/SGI/PT/0012 Author 
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4. Bello Muhammad Abdullateef  ND/23/SGI/PT/0002 Member 

5. Ibrahim Aishat Khadijat  ND/23/SGI/PT/0007 Member 

6. Yahya Ridwan  ND/23/SGI/PT/0006 Member 

7. Betiku Funmilola Oyinkannsola  ND/23/SGI/PT/0005 Member 
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CHAPTER TWO 

2.0  Literature Review 

In the field of construction and civil engineering, maintaining accurate 

documentation of a project’s actual layout and physical configuration is critical for both 

current project execution and future facility management. As-built surveys serve this 

essential role by capturing the precise dimensions and locations of constructed elements 

upon project completion or during various stages of construction. These surveys compare 

the built structure to the original design, identifying discrepancies and ensuring that any 

modifications made during the construction process are properly documented. As-built 

surveys are indispensable for architects, engineers, facility managers, and contractors, 

particularly in complex projects such as bridges, highways, commercial buildings, and 

industrial facilities (Sampaio & Henriques, 2018). Their significance has increased with 

the adoption of Building Information Modeling (BIM) and other digital technologies that 

demand real-time and accurate project data. 

An as-built survey is a detailed representation of a construction project as it was 

actually constructed, rather than as it was originally designed. This survey captures all the 

changes and deviations from the initial blueprints that occur during construction due to 

site conditions, design alterations, or errors in execution (Ayeni et al., 2020). It involves 

measuring, documenting, and mapping structural elements and utilities as they exist, 

which serves as an authoritative reference for final project approvals, asset management, 

and renovations. Unlike design drawings, which are predictive and idealized, as-built 

drawings are retrospective, capturing the completed work’s real-world conditions. 
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Various methods are employed to conduct as-built surveys, depending on the 

scale, complexity, and required accuracy. Traditional techniques involve total stations 

and GPS instruments to measure and map coordinates. These are still widely used for 

simple or linear projects like roadways or pipelines. However, for complex buildings and 

infrastructure, advanced technologies such as 3D laser scanning (LiDAR) and 

photogrammetry have become the standard. These technologies provide high-resolution, 

three-dimensional representations of existing structures, making it easier to capture 

minute details (Tang et al., 2010). Laser scanners emit thousands of laser beams per 

second to capture the spatial geometry of surfaces, while drones equipped with 

photogrammetric cameras provide aerial images to map larger areas efficiently. Data 

from these methods are processed using CAD or BIM software to produce accurate and 

scalable as-built models (Volk et al., 2014). 

The result of an as-built survey is a comprehensive set of drawings or digital 

models that reflect the exact status of a project post-construction. These include locations 

of walls, columns, plumbing, HVAC systems, electrical networks, and other structural or 

architectural features. The findings from as-built surveys are crucial for quality control, 

ensuring regulatory compliance, and settling disputes between stakeholders (Dore & 

Murphy, 2012). When integrated with BIM, the results not only support facility 

management but also aid in predictive maintenance, retrofitting, and future upgrades. In 

many projects, discrepancies revealed by as-built surveys have prevented costly errors in 

renovation or expansion phases. For instance, in infrastructure projects, they can help 

utilities companies avoid damaging existing underground pipes and cables during 

excavation. 
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As-built surveys are an essential component of modern construction and 

infrastructure development. They provide an accurate record of the built environment, 

support legal and regulatory documentation, and enhance the efficiency of maintenance 

and renovation operations. The evolution of survey methods, especially the integration of 

3D scanning and BIM, has greatly improved the accuracy and utility of as-built 

documentation.  

As-built surveys are an essential component of modern construction, ensuring that 

the actual built structure aligns with or documents deviations from the original design. 

These surveys are crucial during and after construction for quality assurance, regulatory 

compliance, and facility management. Their importance has grown with the integration of 

digital tools such as BIM and 3D scanning technologies (Volk et al., 2014). 

An as-built survey is a process of documenting the physical state of a structure or 

site after construction, capturing all alterations and differences from design plans. It 

results in accurate representations, such as drawings or digital models, used for future 

renovations, operations, or legal records (Ayeni et al., 2020). 

Common methods include total station and GPS-based surveying for basic 

measurements. For higher accuracy, 3D laser scanning (LiDAR) and photogrammetry are 

used to produce detailed point clouds and models. These are processed with CAD or BIM 

software to create precise as-built documentation (Tang et al., 2010). 

As-built surveys produce final drawings or models that reflect the real-world state 

of the structure. These outputs support project verification, client handover, asset 
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management, and help prevent errors in future construction phases. In many projects, 

they are also used to detect construction deviations and support claims or disputes (Dore 

& Murphy, 2012). 

As-built surveys play a pivotal role in delivering accurate post-construction data. 

They enhance project transparency, reduce future errors, and are becoming increasingly 

vital with the adoption of digital construction practices. Investing in modern surveying 

methods significantly improves project outcomes and lifecycle management. 

The as-built survey is a vital component of construction and civil engineering, 

capturing the exact state of a built structure for comparison with design plans. It serves as 

a critical reference for ensuring compliance, managing infrastructure, and planning future 

modifications. With advancements in digital technology, the process has become faster, 

more accurate, and more widely adopted across projects (Sampaio & Henriques, 2018). 

An as-built survey is the systematic documentation of a completed construction 

project that reflects the actual positions and dimensions of all components as they were 

constructed, not merely as they were designed. It is essential for identifying variations, 

updating records, and ensuring a reliable foundation for operations and maintenance 

(Ayeni et al., 2020). 

Traditional methods such as tape measurements and total stations have evolved to 

include modern technologies like GNSS, LiDAR (3D laser scanning), and drone-based 

photogrammetry. These tools gather highly accurate spatial data that can be processed 
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using AutoCAD or BIM software, yielding detailed 2D or 3D models of the completed 

structure (Tang et al., 2010; Volk et al., 2014). 

The outcome of an as-built survey is a set of precise drawings or models that 

serve as the definitive representation of a structure. These deliverables are used for 

facility management, maintenance, future renovations, and legal documentation. They 

also help reduce construction disputes by providing a clear record of the completed work 

(Dore & Murphy, 2012). 

As-built surveys provide indispensable post-construction documentation, offering 

a clear picture of what was actually built. As the demand for digital construction and 

smart facility management grows, integrating accurate as-built data becomes more 

essential. Embracing modern surveying technologies ensures greater accuracy, efficiency, 

and long-term value in project management. 

In the construction and civil engineering industry, the accuracy of built structures 

compared to their initial designs is critical for safety, functionality, and future 

modifications. As-built surveys provide a vital record of what was actually constructed, 

supporting decision-making in maintenance, renovations, and compliance (Mahdjoubi et 

al., 2015). These surveys bridge the gap between design intent and construction reality. 

An as-built survey is a detailed documentation process that records the true dimensions, 

locations, and specifications of a completed or partially completed structure. Unlike 

design drawings, as-built records reflect real-world changes and adjustments made during 

construction (Ashmore et al., 2021). These are often used for facility management, legal 

validation, and future project planning. 
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Techniques used in as-built surveys range from manual measurements and total 

station surveys to advanced technologies like LiDAR (Light Detection and Ranging), 

photogrammetry, and UAV (drone) mapping. These methods provide accurate 3D models 

and point cloud data, which are processed with AutoCAD or BIM software to generate 

reliable documentation (Ghaffarian hoseini et al., 2017). 

As-built surveys result in precise digital or printed records that show the actual 

state of construction, including any deviations from the original design. These records are 

used to ensure project compliance, support maintenance, and facilitate upgrades. They 

also reduce the risk of errors and improve stakeholder communication throughout the 

facility's lifecycle (Sacks et al., 2018). 

As-built surveys are indispensable tools in ensuring accuracy, compliance, and 

efficiency in construction projects. Their role has become even more critical with the 

adoption of digital tools that integrate design and reality. Accurate as-built documentation 

not only supports project delivery but also ensures long-term asset management and 

sustainability. 
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CHAPTER THREE 

3.0  Methodology  

This aspect refers to a system of methods and principles, rules used in a field of 

study to achieve the aim and objectives of this project. The modality to successful 

execute this project was carried out based on the survey rules and regulation, supervisor 

advice and departmental instructions. 

 

3.1  Reconnaissance  

Reconnaissance survey is a preliminary stage for exploratory investigations 

conducted to gather initial data concern the choice of Site area of Subject before more 

detailed research or filed work commenced. Reasons for reconnaissance survey of the 

project area are the following; 

i. To know the location of the site. 

ii. To determine the preliminary area/perimeter of the land. 

iii. To know the survey method suitable for the field data acquisition and the instrument need 

for the it. 

Reconnaissance in this project involved preliminary investigations to gather 

information about the survey area before conducting a detailed survey, reconnaissance of 

this project was carried out in two way namely as follows. 

i. Office planning 

ii. Field Reconnaissance 
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3.1.1  Office Planning 

It involved the process adopted in the collection of relevant data and specification 

about the as-built Surveying with the used of traversing survey method. During the office 

planning the given coordinate for control point HND2001, TBM0110, and HND2002, 

was obtained and computed as shown in the table 3.1 below. The choice of equipment to 

be use for project was obtained from the survey store in the department of surveying and 

Geoinformatic, Kwara State Polytechnic, Ilorin, and it was handled accordingly to the 

survey rules and regulations and departmental instruction. 

TABLE 3.1 Showing the list of the coordinate of the control pillars used  

Stations Northing (m) Easting (m) Remark 

HND2001 937892.5580  668076.4680   Given 

TBM0110 937900.4120   668069.5750   Given 

HND2002 937909.7109   668061.2683   Given 

 

3.1.2  Field Reconnaissance  

Field recce and site visitation was conducted as preliminary survey for 

investigation of the basic information about a specified project area, location, or subject 

in the field. It allows the members of the groups to be familiar with the terrain, boundary 

lines, selection number of station required, Equipment that will be used for the job, pillars 

number HND2001, TBM0110, and HND2002 used as a control for the project and so on. 

The stations points selected was Inter-visible to one another and finally a reconnaissance 

diagram was produced which was attached to this project 
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RECCE DIAGRAM 
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3.2 Instrument Selection 

The equipment used for this project was grouped into two categories;  

i. Hardware  

ii. Software 

3.2.1 Hardware used  

i. Total Station with its Accessories (KTS-442L) 

ii. Reflector poles 

iii. Field book 

iv. Writing material (pen)  

v. Survey beacons 

vi. Steel Tape (5m) 

vii. Tripod Stand 

3.2.2 Software used  

Below are the list of the software used during the project processing;  

i. AutoCAD 2007 

ii. Notepad 

iii. Microsoft word 

iv. Microsoft Excel 

 

3.3  Instrument Test  

The instrument test was carried out before it used for angular observation. The 

purpose of testing the instrument before used is to know the assurance and maybe other 

instrument is in good Condition the instrument was set up over station A and it was 
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pointed a Sighted to station B whore a pole Is hold, and the angle was recorded for face 

left the instrument was turn to farce right on the same point and it was sighted to station 

B, where a pole is held at the same position and the angle was recorded. The distance 

between station A and B 1s 10m. The steel tape was hold at 60m an point A and it was 

extend to point B. the results for the instrument test was shown i to figure 3.3 below and 

table 3:2 below. 

 

 

 

 

 

 

 

 

Figure 3.1 showing the instrument set up for collimation test  

Table 3.2 showing the test of instrument result  

STATION SIGHT FACE HORIZONTAL 

READING 

DEDUCED 

ANGLE 

A B L 180° 00’ 03”  

 B R 00°00’ 00” 180° 00’ 03” 

Different in horizontal circle reading: 180° 00’ 03’’ 

Horizontal collimation error  

= 180° 00’ 03’’ 

Total station 
LINE OF SIGHT 

RANGING POLE 

20M 

STATION  X TERRAIN STATION  Y 
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= 000° 00 03’’ 

  Collimation error = 
00° 00′03"

2
 

Horizontal collimation error = 00° 00’ 01” 

Because the collimation  error falls within the allowable 01”. The instrument was in good 

condition. 

3.4  Monumentation  

This is the process in which the beacon is being buried in to ground. On the 

project site there are same existing beacons on the boundary lines m, nail with cap (bottle 

cork) was used as the  station pegs. 

 

 

 

 

 

 

 

 

 

 

         PILLAR          PEG 

 FIGURE 3.4 Diagram and Dimension of Pillars buried 

 

 

18cm 

15cm above the ground 

60cm below the ground 

18cm 

30cm 

Nail 

Bottle cork 
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3.5  CONTROL CHECK  

The Control check was carried out to know the control point HND2001, 

TBM0110, and HND2002 are still in their positions. The instrument was set on Control 

FP01107 and the temporary adjustment was carried out i.e centring, levelling, and 

focusing. Back site was taken to control HND2001 and it was recorded. 

The fore sight was served to PEG1 and it was recorded Steel tape was used to measure 

the distance between TBM0110 and PEGI and it was recorded. The data observed was 

computed for given coordinate and Observed Coordinate, as shown in the table 3.2 

below. 

TABLE 3.2 THE GIVEN COORDINATE OF THE CONTROL POINTS 

Stations Northing (m) Easting (m) Remark 

HND2001 937892.558 668076.468  Given 

TBM0110 937900.412 668069.575 Given 

HND2002 937909.711   668061.268 Given 

 

TABLE 3.3 The Backward Computation for the Given Controls pillars 

From 

station 

Bearing Distance ∆𝑵 ∆𝑬 Northing 

      (m) 

Easting 

     (m) 

To station 

     937892.558 668076.468  HND2001 

HND2001 318° 43' 42’’ 10.472 7.854  -6.893   937900.412 668069.575 TBM0110 

TBM0110 318° 13' 33’’   12.469   9.299   -8.307  937909.711   668061.268 HND2002 

 

TBM0110  to HND2002  BEARING = 318° 13' 33’’   DISTANCE = 12.469m   

 HND2002 to TBM0110  BEARING = 138° 43' 42’’ DISTANCE = 10.472m 
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TABLE 3.4 Show the Observed Coordinate of the Controls Pillars 

Stations Northing (m) Easting (m) Remark 

HND2001 937892.550 668076.460  Observed 

TBM0110 937900.412 668069.575 Observed 

HND2002 937909.715   668061.271 Observed 

 

TABLE 3.5 Show the Backward Computation for the Observed Control Pillars 

From 

station 

Bearing Distance ∆𝑵 ∆𝑬 Northing 

      (m) 

Easting 

     (m) 

To station 

     937892.550 668076.460  HND2001 

HND2001 318° 43' 25’’ 10.451 7.862 -6.885 937900.412 668069.575 TBM0110 

TBM0110 318° 14' 51’’   12.470  9.303  -8.304  937909.715   668061.271 HND2002 

 

TBM0110  to HND2002  BEARING = 318° 13' 51’   DISTANCE = 12.470m   

 HND2002 to TBM0110  BEARING = 138° 43' 25’’ DISTANCE = 10.451m 

Therefore the difference between the given and observer bearing was 00° 00’ 19” 

and 00° 00’ 17” and the difference between the given and the observer linear distance 

was 0.003m and 0.021m the results obtained fall within the allowable accuracy for both 

angular and linear observation. 

It was concluded the instrument was in good condition and fit to be used for the project.   

3.6  Data Aquisition  

This was carried out on the field using Total station with its accessories (KTS-

442L) was used for coordinating the entire site for both the perimeter and details of the 

site. The Total station was set on the  control Pillar TBM0110, and the temporary 
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adjustment was carried out centering, leveling and  focusing. The coordinates of the 

occupied station was input after that the coordinates of the backsight HND2001 was 

record as well and the observation was done to backsight pillar and the coordinates was 

take and check against the given. Having check and found accurate then the perimeter 

survey commenced for the entire project site. 

3.6.1  Detailing Survey 

The detailing survey was done immediately after completely carried out the 

perimeter traverse to determine the position of the features on the Site was fixed using 

radiation survey method. During this several stations was established to pick the 

coordinates of the details and the coordinates was stored on the total station as its 

observed. This was later downloaded. The details that was picked during the detailing 

survey was coded in different ways like Building edges as ‘BLD’, Electric Poles ‘EP’, 

Drainage ‘DR’, Roads Line ‘RD’, Spot Height ‘SP’ and so on.  
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CHAPTER FOUR 

4.0    Data Processing  

This involved several step to ensure accurate and reliable result. It explains the 

method used in capturing; processing, downloading, and analyzing the data acquired Data 

reduction in surveying involves various methods to simplify and summarize the collected 

data for analysis. These are some common methods of data reduction that involves   

 Combining multiple values into a single value. The average value is calculated by 

summing up all the values and dividing by the number of values. 

 Least Square Adjustment (LSA) is a method of data reduction that involves minimizing 

the sum of the squared errors between observed and calculated values. 

 Interpolation is a method of data reduction that involves estimating values between 

observed data points.  

 Spatial data reduction refers to the process of simplifying and reducing the complexity of 

spatial data, such as geographic information system (GIS) data, while preserving its 

essential characteristics. 

4.1 Data Editing  

 Open excel 

 Click on the desire file 

 Set to delimited  

 Click on next 

 Mack space and comma 

 Click 

 On next 
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 Then click on finish 

4.3 Data Processing Using Autocad 

The plan produced digitally with AutoCAD software. The following are the 

procedure used: 

STEP 1: Open Notepad 

Open Notepad on your computer. You can find it in the start menu (Window) 

STEP 2: Create a New File 

Click on "file" "New" to create a new file 

STEP3: Enter Coordinates 

Enter your coordinates in the following format: 

X. Y. Data 

STEP 4: Save the Fil 

Click on "File" > "Save as" and choose a location to save your file. "ALADA 

Coordinate" txt,  and select "All files" as the file type. 

 Importing the Coordinate File Into 2007 AutoCAD 

 STEP 1: Double click AutoCAD 

 Go under format 

 Click on format after that pick your unit 

 Drawing unit 

 Type.... Decimal 

 Precision... 0.000 

 Angle type Degree/Min/See 

 Precision Od00 
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 Clockwise.... 노 

 Unit to scale Meters 

 Direction control North 270d0 

 Press "OK" 

 STEP 2: Create a new drawing 

 Click on "File" > "Name" to create a new drawing 

 STEP 3: Import the coordinate file 

 Click on "Tools" >"Reference" > "Import" and select "ALADA coordinate (.txt)" 

as the file  type. Navigate to the location where you saved your coordinate file 

("ALADA coordinate .txt")  and select it. 

STEP 4: Configure Import Setting. In the import select "Point" as the object type and 

choose  the correct coordinate format (eg. X and Y) click "OK" to import the 

coordinates. 

4.4 Data Extraction 

The data recorded in the field book was picked to compute for the bearing and 

distance. Forward computation and backward computation after all necessary correction 

have been applied. Correction like slope correction, tension correction and 

standardization correction. 

 

 

 

 

 



 39 

4.3   Back Computation  

The result get for forward computation was used for Back computation. 

The following program was required for back computation  

i. Input N2-N1 to get ∆N 

ii. Input E2-E1 to get ∆E 

iii.Input √(∆𝑁2 + ∆𝐸2 to get distance  

iv.Input shift tan 
∆𝐸

∆𝑁
to get the corrected bearing when there us more station repeat step ¡¡¡ and ii. 

Table 4.1 Showing Boundary Coordinates  

Station  Northing (m) Easting(m) Remark 

PIL1 937720.924 668157.605 Observed 

PIL2 937720.560 668042.167 Observed 

PIL3 937748.847 667988.759 Observed 

PIL4 937788.194 667965.709 Observed 

PIL5 937930.248 668056.923 Observed 

PIL6 937924.001 668159.813 Observed 
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Table 4.1.1 Showing back computation for the boundary coordinate   

Station 

form    

Bearing   Distance      ∆N      ∆E    

 

Northing   Easting Station to 

     937720.924 668157.605 PIL 1 

PIL1 89° 49’ 09’’    115.484 0.364 115.438 937720.560 668042.167 PIL 2 

PIL 2 117° 54’26’’ 45.302 -28.287 53.408 937748.847 667988.759 PIL 3 

PIL 3 149° 38’ 15” 31.887 -39.347 23.05 937788.194 667965.709 PIL 4 

PIL 4 180° 35’ 31” 108.901 -142.054 -91.214 937930.248 668056.923 PIL 5 

PIL 5 253° 31’ 46” 102.700 6.247 -102.89 937924.001 668159.813 PIL 6 

PIL 6 360° 00’ 39” 203.082 203.077 2.208 937720.924 668157.605 PIL 1 
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4.4 Area Computation 

TABLE 4.1.2 showing area computation for the boundary coordination using 

double latitude  

  

∆E ∆N PRODUCT  

115.438 X 0.364 = 42.019432 

115.438   

230.876   

 53.408   

284.284 X -28.287 =-8041.541508 

53.408   

337.692   

23.05   

360.742 X -39.347 =-14194.11547 

23.05   

283.792   

-91.214   

292.578 X -142.054 = -41561.87521 

-91.214   

201.364   

-102.89   

98.474 X 6.247 = 615.167078 

-102.89   

-4.416   

2.208   

-2.208 X 2203.077 = -448.394016 

2.208   

0.000      
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= 42.01943 – 8041.541508 – 14194.11547- 41561.87521+ 615.167078 – 448.394016 

 = -63588.73969\2          

 = 31794.36985m²\10,000.         

 = 3.1794 HECTRES 

4.5 PLAN PRODUCTION 

All the plan were produces in both soft copies and hard copies, the hard copies 

were shown on the appendix page attached with the project. 
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CHAPTER FIVE 

5.0  SUMMARY, PROBLEMS ENCOUNTERED, CONCLUSION, 

RECOMMENDATION 

5.1  SUMMARY  

In order to determine the shape, size and location of the Kwara state Polytehnic 

Mini Campus, reconnaissance was carried out which helps in taking further decisions. 

Beacons were coordinated using total station with the help of existing control points very 

close to the project site. Data were downloaded and processed using appropriate 

AutoCAD 2007 software and the final adjusted coordinates of the perimeter were used to 

plot the boundary and other details . The resulting plan was printed in scale 1: 2,500. A 

comprehensive Technical report was prepared and printed.  

5.2  PROBLEM ENCOUNTERED  

i. Too much of rainfall which does not allowed site 

ii. Unavailable of the group members due to dean's cup football tournament 

iii. While taking observing there are some object obstructing the view when taking the 

observation e.g electric pole, building, tree etc. 

5.3  RECOMMENDATION 

The department should considered the season and time that the students should be 

given the terminal project. 

5.4  CONCLUSION  

At the end the aim and objective of this project was achieved. It was carried out 

using third order surveying method this project was carried out in accordance with survey 

rules and regulation and departmental instruction. 
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Raw Data 

Name Code E N h   PT260 SH 668115.4 937791.5 317.946 

PT1 ST17 668069.6 937900.4 324.137   PT261 SH 668118 937790.7 318.041 

PT2 CV 668071.1 937900.4 324.553   PT262 SH 668117.7 937795.6 317.967 

PT3 CV 668072 937900.3 324.541   PT263 SH 668113.5 937797.2 317.656 

PT4 BLD 668072.6 937900.6 324.383   PT264 SH 668110.1 937800.8 317.647 

PT5 BLD 668066.5 937905.8 323.724   PT265 SH 668110.4 937806.9 317.571 

PT6 SH 668069.7 937897.9 324   PT266 SH 668114.1 937808.4 317.326 

PT7 SH 668072.6 937896.1 324.671   PT267 SH 668117.8 937810 317.601 

PT8 SH 668072.2 937891.5 324.604   PT268 SH 668117.6 937814.7 317.532 

PT9 SH 668076.5 937892.6 324.821   PT269 SH 668113.8 937816 317.212 

PT10 SH 668083.2 937892.3 324.831   PT270 SH 668109 937815.1 317.485 

PT11 SH 668085.6 937889.4 324.87   PT271 SH 668104.5 937814.4 317.27 

PT12 BLD 668085.4 937886.8 324.848   PT272 SH 668104.8 937819.5 317.197 

PT13 SH 668088.7 937888.5 324.887   PT273 SH 668109.7 937818.5 317.278 

PT14 SH 668090.4 937893.3 324.882   PT274 SH 668113.6 937819 317.192 

PT15 SH 668095.3 937895.1 324.957   PT275 SH 668117.7 937821.2 317.334 

PT16 SH 668095.6 937891.4 324.958   PT276 SH 668114.1 937823.2 317.152 

PT17 BLD 668139.4 937901.3 324.586   PT277 SH 668109 937824.1 317.181 

PT18 CV 668139.1 937901.2 316.047   PT278 SH 668104.9 937822.2 317.161 

PT19 CV 668139.5 937900.4 316.104   PT279 SH 668105 937825.4 317.107 

PT20 CV 668137.3 937899 317.048   PT280 SH 668103.5 937827.1 317.276 

PT21 SH 668133.7 937894.7 316.106   PT281 SH 668108.1 937827.2 317.179 

PT22 SH 668136.7 937894.8 316.021   PT282 SH 668112 937827.1 317.097 

PT23 BLD 668137 937893.5 316.015   PT283 SH 668116.6 937827.5 317.116 

PT24 SH 668141.1 937890.4 315.886   PT284 SH 668117.8 937831.4 317.048 

PT25 SH 668145.9 937889.2 315.599   PT285 SH 668112.9 937833.2 317.012 

PT26 SH 668147.8 937891.6 315.619   PT286 SH 668108.8 937832.7 317.058 

PT27 GT 668148.7 937893.4 315.804   PT287 SH 668106.3 937831.7 317.095 

PT28 GT 668147.9 937894 315.765   PT288 SH 668120.4 937780 318.343 

PT29 BLD 668148.9 937893.2 315.928   PT289 SH 668125.9 937783 318.036 

PT30 SH 668148.1 937886.3 315.852   PT290 SH 668122.6 937785.4 318.043 

PT31 SH 668144.4 937882.9 315.942   PT291 SH 668120.9 937789.4 318.013 

PT32 SH 668140.3 937879.1 316.287   PT292 BLD 668120.6 937791.6 317.908 

PT33 SH 668144.4 937877.2 316.236   PT293 SH 668125 937790.3 317.853 

PT34 SH 668147.4 937877.9 316.065   PT294 SH 668128.5 937785.7 317.944 

PT35 BLD 668149.4 937879.9 315.956   PT295 SH 668133 937781.5 317.952 

PT36 BLD 668156.1 937879.6 315.966   PT296 SH 668132.9 937786.5 317.857 

PT37 BLD 668156 937874.1 315.966   PT297 SH 668132.2 937790.7 317.807 

PT38 EP 668150.9 937875.2 316.093   PT298 SH 668137 937790.8 317.772 

PT39 SH 668152 937878.1 315.912   PT299 SH 668139.7 937786.5 317.824 
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PT40 BLD 668146.3 937874.1 316.297   PT300 SH 668140 937781.4 318.046 

PT41 SH 668132 937896.8 316.129   PT301 SH 668144.3 937781.2 318.023 

PT42 BLD 668128.4 937894.7 316.378   PT302 SH 668145.5 937786.4 317.727 

PT43 SH 668124.8 937894.3 316.451   PT303 SH 668146 937791.2 317.717 

PT44 SH 668121.3 937892 316.499   PT304 SH 668149.5 937790.8 317.75 

PT45 SH 668118.3 937894.3 316.594   PT305 SH 668149.7 937786.7 317.692 

PT46 SH 668115.7 937888.6 316.573   PT306 SH 668148.9 937781.3 317.842 

PT47 BLD 668113.6 937886.9 316.529   PT307 BLD 668150.4 937781.4 317.8 

PT48 SH 668110.4 937889.4 316.736   PT308 BLD 668150 937791.5 317.803 

PT49 SH 668108.3 937891.8 316.596   PT309 SH 668113.7 937768.9 318.789 

PT50 SH 668104.4 937892.2 316.593   PT310 SH 668113.6 937766 318.901 

PT51 SH 668104.2 937889.1 316.626   PT311 BLD 668112.8 937763.3 319.05 

PT52 SH 668117.5 937886.8 316.551   PT312 SH 668117.2 937761.4 318.943 

PT53 SH 668119.7 937883.9 316.541   PT313 SH 668117.5 937764.3 318.911 

PT54 SH 668117.1 937883.2 316.562   PT314 SH 668122.4 937765.5 318.977 

PT55 SH 668114.2 937882.6 316.592   PT315 SH 668124.5 937762.3 318.933 

PT56 BLD 668113.5 937874.4 316.659   PT316 SH 668122.4 937758.6 318.969 

PT57 SH 668115.5 937874 316.641   PT317 SH 668121.7 937753.2 319.012 

PT58 SH 668117.6 937873.9 316.666   PT318 SH 668119.4 937752.3 319.022 

PT59 SH 668116.9 937866.3 316.759   PT319 BLD 668113 937752.1 319.283 

PT60 SH 668114.9 937865.7 316.81   PT320 BLD 668113.1 937748.7 319.275 

PT61 SH 668112.2 937865.8 317.066   PT321 BLD 668113.2 937730.1 319.819 

PT62 BLD 668111.7 937870.2 316.664   PT322 BLD 668118.1 937726.7 320.172 

PT63 SH 668124 937868.3 316.542   PT323 BLD 668118.2 937750.2 319.117 

PT64 BLD 668129.2 937867.4 316.594   PT324 SH 668122.5 937751.6 319.006 

PT65 SH 668128.1 937869.8 316.579   PT325 SH 668124.5 937754.3 318.972 

PT66 SH 668127.9 937872.5 316.566   PT326 SH 668125.4 937757 318.942 

PT67 SH 668125 937873.8 316.569   PT327 SH 668126.4 937759.8 318.902 

PT68 SH 668123.6 937877 316.822   PT328 SH 668127.7 937763.6 318.945 

PT69 SH 668126 937879.4 316.682   PT329 SH 668129.6 937766.7 319.003 

PT70 SH 668121.7 937869.6 316.558   PT330 SH 668132.3 937766.4 319.052 

PT71 SH 668121.5 937862 316.817   PT331 SH 668132.9 937763.9 319.098 

PT72 SH 668123.1 937858.4 316.857   PT332 SH 668133.1 937760.8 318.995 

PT73 SH 668118.9 937856.2 316.91   PT333 SH 668133.8 937757.1 318.991 

PT74 BLD 668120.4 937852 316.833   PT334 SH 668134 937753.4 318.981 

PT75 SH 668116.8 937852.9 316.833   PT335 SH 668134.5 937750.7 319.07 

PT76 CV 668119 937855.1 316.791   PT336 BLD 668137.6 937750.4 319.035 

PT77 CV 668118.5 937855.2 316.819   PT337 SH 668138.2 937752.8 319.024 

PT78 SH 668111.8 937851.5 317.396   PT338 BLD 668140.6 937755.3 318.91 

PT79 SH 668115.7 937850.6 316.866   PT339 SH 668137.7 937757.7 319.018 

PT80 SH 668118.3 937849 316.835   PT340 SH 668136 937762 319.013 

PT81 SH 668118.1 937843.1 316.939   PT341 SH 668138.3 937764.7 319.044 

PT82 SH 668113.8 937842.7 316.91   PT342 BLD 668139.4 937765.7 319.051 
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PT83 SH 668108.1 937843.3 317.4   PT343 SH 668141.4 937749.2 319.111 

PT84 SH 668106.1 937847.2 317.641   PT344 SH 668143.4 937751 319.05 

PT85 SH 668102.4 937849.2 317.563   PT345 SH 668144.9 937753.8 318.948 

PT86 SH 668101.2 937843.6 317.586   PT346 SH 668147.2 937751.6 318.691 

PT87 SH 668099.2 937840.3 317.489   PT347 SH 668146.9 937747.9 319.135 

PT88 SH 668098.1 937836.4 317.051   PT348 SH 668144.5 937745.9 319.098 

PT89 SH 668094.9 937829.9 317.405   PT349 SH 668143.8 937741.8 319.252 

PT90 SH 668099 937830 317.366   PT350 BLD 668137.8 937739.5 319.454 

PT91 SH 668102.2 937835.3 317   PT351 SH 668140 937740.1 319.295 

PT92 SH 668093 937842.7 317.597   PT352 SH 668141.4 937742 319.263 

PT93 SH 668090.5 937849.3 317.02   PT353 SH 668145.1 937740.6 319.475 

PT94 SH 668088 937845.4 317.154   PT354 SH 668147.6 937743.1 319.297 

PT95 CV 668089.1 937840.1 317.01   PT355 SH 668149.8 937746.8 319.15 

PT96 CV 668089.5 937840.1 317.036   PT356 SH 668151.4 937750.4 319.144 

PT97 CV 668089.7 937835.1 316.97   PT357 SH 668153.9 937753.9 319.13 

PT98 CV 668089.1 937835.1 316.951   PT358 BLD 668156.8 937753.8 319.16 

PT99 SH 668087.3 937837.4 317.032   PT359 BLD 668155 937750.1 319.175 

PT100 SH 668084.9 937841.3 317.015   PT360 GT 668156.7 937750.4 319.189 

PT101 SH 668081.1 937845.6 316.694   PT361 GT 668156.4 937744 319.379 

PT102 BLD 668082.4 937849.5 316.774   PT362 BLD 668151.3 937744.1 319.293 

PT103 SH 668079.2 937850.8 316.576   PT363 BLD 668157.6 937720.9 319.595 

PT104 SH 668076.3 937851.1 316.606   PT364 BLD 668075.3 937717.9 320.555 

PT105 SH 668076.4 937857.2 316.522   PT365 BLD 668042.2 937720.6 320.353 

PT106 SH 668079.6 937859 316.481   PT366 BLD 668036 937729.4 320.261 

PT107 SH 668082.3 937859.3 316.539   PT367 BLD 668035.2 937744.9 319.623 

PT108 SH 668081.6 937865.3 316.444   PT368 BLD 668011 937744.6 320.389 

PT109 SH 668078.7 937867 316.454   PT369 BLD 668000.4 937749.6 319.55 

PT110 SH 668075.8 937866.3 316.351   PT370 BLD 667993.6 937757.8 318.942 

PT111 SH 668074 937869.4 316.329   PT371 BLD 667980.6 937772.8 318.59 

PT112 SH 668078.7 937870.4 316.547   PT372 BLD 667974.3 937782.4 318.279 

PT113 SH 668081.1 937872.7 316.472   PT373 BLD 667968.1 937789.6 318.03 

PT114 SH 668081.9 937877.2 316.469   PT374 RD 667966.1 937793.6 317.734 

PT115 SH 668079 937877.3 316.472   PT375 CL 667964.4 937795.8 317.839 

PT116 SH 668076.3 937876 316.604   PT376 RD 667962.9 937797.2 317.658 

PT117 EP 668074.3 937876.1 316.594   PT377 SH 667967.3 937798.1 317.599 

PT118 TM 668071.8 937879 316.342   PT378 SH 667972.1 937795.5 317.821 

PT119 TM 668076.7 937878.8 316.445   PT379 SH 667976.9 937798.1 317.559 

PT120 TM 668077.2 937885.8 316.536   PT380 SH 667975.5 937802 317.229 

PT121 SH 668079.9 937885 316.362   PT381 SH 667973.8 937805.3 317.111 

PT122 SH 668082.8 937883.4 316.48   PT382 SH 667974.4 937809.3 317.087 

PT123 SH 668079.8 937880.6 316.437   PT383 SH 667980.3 937808.6 317.008 

PT124 SH 668064.8 937896.9 315.429   PT384 SH 667986.3 937808.3 317.055 

PT125 BLD 668064.8 937885.4 315.743   PT385 SH 667989 937806.7 317.471 
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PT126 SH 668069.7 937888.7 315.93   PT386 SH 667991.4 937808.2 317.321 

PT127 SH 668069.8 937882.8 315.817   PT387 BLD 667995.8 937809.1 317.181 

PT128 EP 668066.9 937881.4 316.367   PT388 BLD 667996.6 937819.4 317.014 

PT129 BLD 668073.2 937873.9 316.28   PT389 BLD 667997.1 937825.8 316.715 

PT130 SH 668076.5 937842.5 316.803   PT390 BLD 667997.7 937836.1 316.436 

PT131 SH 668080.9 937837.3 316.882   PT391 SH 667999.8 937837.9 316.489 

PT132 SH 668076.4 937833.4 317.117   PT392 SH 668004.1 937837 316.697 

PT133 SH 668079.1 937829.3 317.088   PT393 SH 668006.3 937835.7 316.836 

PT134 SH 668084.6 937829.3 317.095   PT394 SH 668012.2 937839.5 317.101 

PT135 SH 668084.6 937825.2 317.166   PT395 BLD 668024 937834.2 316.943 

PT136 SH 668080.9 937824.4 317.192   PT396 EP 668028.4 937833.8 316.701 

PT137 EP 668075.2 937830.8 317.409   PT397 SH 668027.3 937830.5 316.834 

PT138 SH 668076.5 937824.8 317.309   PT398 SH 668024.8 937827.5 316.95 

PT139 SH 668080.1 937820.9 317.285   PT399 SH 668027.4 937825.1 316.977 

PT140 SH 668083.9 937818.9 317.208   PT400 SH 668025.7 937818 317.088 

PT141 SH 668084.3 937814.6 317.38   PT401 BLD 668022.6 937817.1 317.238 

PT142 SH 668080.3 937812.9 317.483   PT402 SH 668025.6 937813.3 317.258 

PT143 SH 668077 937811.8 317.722   PT403 SH 668030.1 937809.1 317.516 

PT144 EP 668075.5 937812.1 317.622   PT404 BLD 668031.1 937802.8 317.66 

PT145 CV 668075.9 937810.5 317.869   PT405 SH 668027.5 937801.2 317.556 

PT146 CV 668076.6 937810.4 317.877   PT406 SH 668031.4 937799.3 317.671 

PT147 CV 668076.1 937808 317.884   PT407 BLD 668035 937801.7 318.075 

PT148 CV 668076.5 937808 317.896   PT408 SH 668032 937800 317.586 

PT149 BLD 668073.4 937815.4 317.468   PT409 SH 668031.4 937796 317.74 

PT150 BLD 668073.5 937803.4 317.824   PT410 SH 668033.4 937793.9 317.725 

PT151 SH 668077.3 937804.7 317.737   PT411 BLD 668035.2 937792.8 317.863 

PT152 SH 668080.4 937805.5 317.546   PT412 BLD 668029.7 937792.2 318.048 

PT153 SH 668083.8 937807.7 317.514   PT413 BLD 668029.5 937779.7 318.482 

PT154 SH 668084 937803.1 317.576   PT414 BLD 668035.6 937839.2 316.76 

PT155 SH 668080.5 937801.9 317.645   PT415 BLD 668030 937849.5 316.014 

PT156 SH 668076.8 937799.4 318.005   PT416 BLD 668014.7 937849.8 315.771 

PT157 SH 668080.5 937797 317.729   PT417 RD 668001.4 937850 315.553 

PT158 SH 668084.2 937798.5 317.584   PT418 RD 667996.5 937852.3 315.646 

PT159 SH 668086.6 937795.5 317.625   PT419 BLD 668015.4 937870.2 315.216 

PT160 SH 668088.9 937794.7 317.784   PT420 RD 668022.4 937889 314.617 

PT161 SH 668087.8 937791.7 318.04   PT421 RD 668020.3 937890.7 314.467 

PT162 BLD 668090.2 937790.5 318.057   PT422 BLD 668035.6 937896.8 314.523 

PT163 SH 668086 937790 318.019   PT423 CV 668032.5 937898.1 314.441 

PT164 SH 668079.9 937790.6 317.829   PT424 CV 668032.1 937898.6 314.354 

PT165 SH 668076.8 937791.1 317.997   PT425 EP 668026.8 937902.6 314.367 

PT166 EP 668075.9 937791.5 318.028   PT426 EP 668042.4 937923.4 313.423 

PT167 SH 668081.3 937788.3 317.911   PT427 EP 668045.7 937913.1 313.825 

PT168 SH 668086.2 937787 318.037   PT428 CV 668045.7 937915.3 314.041 
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PT169 SH 668088.3 937782.1 318.256   PT429 CV 668045.2 937915.7 314.017 

PT170 SH 668083.1 937782.1 318.113   PT430 RD 668050.4 937924.9 313.193 

PT171 SH 668077.2 937783.1 318.448   PT431 RD 668048 937928.1 313.163 

PT172 SH 668077.1 937779.4 318.482   PT432 CL 668049.6 937927.2 313.142 

PT173 SH 668080.8 937779.2 318.382   PT433 BLD 668057.8 937924.9 313.443 

PT174 SH 668086.1 937777 318.527   PT434 BLD 668139.5 937920.4 313.76 

PT175 SH 668088.4 937774.7 318.351   PT435 BD 668156.3 937920.7 312.957 

PT176 CV 668076.7 937775.7 318.733   PT436 BLD 668156.4 937893.6 315.143 

PT177 CV 668076.4 937775.7 318.755   PT437 BLD 668120.5 937803.6 317.77 

PT178 SH 668075.6 937773.1 318.598   PT438 SH 668121.8 937806.3 317.702 

PT179 BLD 668073.5 937768.6 318.708   PT439 BLD 668120.3 937810 317.679 

PT180 SH 668073.1 937767.9 318.686   PT440 SH 668124.2 937808.2 317.693 

PT181 SH 668075.1 937765.4 318.807   PT441 SH 668124.2 937805.5 317.683 

PT182 BLD 668076.2 937763 318.99   PT442 SH 668127.7 937808.3 317.623 

PT183 SH 668077.8 937762.3 318.92   PT443 SH 668129.9 937805.3 317.555 

PT184 SH 668079.4 937758.5 319.226   PT444 SH 668132.3 937808.2 317.557 

PT185 SH 668076.9 937758.6 318.98   PT445 SH 668135.2 937805 317.569 

PT186 SH 668079.6 937754.5 319.302   PT446 SH 668139.8 937808.7 317.523 

PT187 SH 668077.8 937753.6 319.218   PT447 SH 668142.5 937806.5 317.477 

PT188 SH 668078.5 937746.8 319.408   PT448 SH 668143.5 937805.6 317.641 

PT189 SH 668076.3 937744 319.51   PT449 BLD 668152.8 937810.8 317.334 

PT190 SH 668079.7 937740.7 319.611   PT450 BLD 668152.8 937803.9 317.388 

PT191 SH 668080.3 937743.2 319.569   PT451 BLD 668120.4 937826.9 317.189 

PT192 SH 668078.8 937739.9 319.631   PT452 SH 668123.3 937828 316.989 

PT193 SH 668078.8 937737.1 319.719   PT453 SH 668126.8 937828.7 316.943 

PT194 SH 668081 937736.3 319.732   PT454 SH 668126.3 937832 316.931 

PT195 SH 668078.1 937736.2 319.726   PT455 SH 668123.9 937832.8 316.937 

PT196 SH 668074.3 937736.5 319.73   PT456 SH 668121.8 937833.5 316.965 

PT197 BLD 668076 937739.9 319.718   PT457 SH 668128 937833 316.904 

PT198 SH 668070.5 937735 319.725   PT458 SH 668128.4 937836.4 316.889 

PT199 SH 668067.7 937732.6 319.769   PT459 SH 668135.6 937832.3 316.921 

PT200 SH 668065.8 937735.6 319.673   PT460 SH 668134.3 937834.4 316.926 

PT201 SH 668064.2 937739.6 319.579   PT461 SH 668138.4 937829.2 316.911 

PT202 SH 668061 937736.3 319.632   PT462 SH 668141.1 937835.5 316.628 

PT203 SH 668060.3 937732.6 319.705   PT463 SH 668120.5 937838.7 317.002 

PT204 SH 668057.4 937735.8 319.652   PT464 BLD 668073.3 937862.2 316.453 

PT205 SH 668056.3 937739.5 319.449   PT465 SH 668072.4 937859 316.477 

PT206 SH 668052.5 937736.1 319.664   PT466 SH 668069.5 937857 316.409 

PT207 SH 668050.9 937732.6 319.757   PT467 SH 668065.8 937859.2 316.319 

PT208 SH 668048.6 937736.2 319.724   PT468 SH 668064.3 937857.5 316.229 

PT209 BLD 668043.3 937739.9 319.659   PT469 SH 668063.9 937853.2 316.483 

PT210 BLD 668043.6 937731.8 319.686   PT470 SH 668055.7 937859.2 316.296 

PT211 BLD 668075.8 937729.8 319.966   PT471 SH 668050.3 937854.7 316.365 
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PT212 BLD 668079.9 937728.9 320.175   PT472 BLD 668050.1 937852.9 316.654 

PT213 BLD 668079.7 937763.4 318.77   PT473 SH 668056.8 937852.8 316.47 

PT214 SH 668080.8 937767.6 318.711   PT474 SH 668063.8 937852.2 316.438 

PT215 SH 668083.6 937771.3 318.618   PT475 SH 668067.5 937853.8 316.473 

PT216 CV 668088.4 937773.9 318.388   PT476 BLD 668073.3 937851.7 316.674 

PT217 CV 668088.4 937774.1 318.401   PT477 BLD 668073.4 937838.8 317.02 

PT218 CV 668088.9 937774.3 318.362   PT478 SH 668071.2 937834.5 316.988 

PT219 CV 668089.2 937774.2 318.355   PT479 SH 668071.7 937829.5 317.224 

PT220 CV 668089.7 937774 318.348   PT480 BLD 668073.4 937827.2 317.205 

PT221 CV 668089.7 937773.6 318.358   PT481 SH 668067.6 937828.1 317.111 

PT222 SH 668092.5 937776.3 318.551   PT482 SH 668064.6 937832.8 317.034 

PT223 SH 668090.5 937779.5 318.338   PT483 SH 668061.8 937837.4 316.978 

PT224 SH 668092.9 937780.6 318.233   PT484 SH 668056.2 937836.7 316.98 

PT225 SH 668091.7 937784.1 318.136   PT485 SH 668057.4 937831 317.048 

PT226 SH 668090.5 937787.6 318.117   PT486 SH 668058.5 937827.6 317.15 

PT227 SH 668095.2 937788.3 318.215   PT487 SH 668050.6 937828 316.962 

PT228 SH 668098.3 937788.8 318.206   PT488 SH 668049.9 937833.6 316.97 

PT229 SH 668098.2 937786.1 318.204   PT489 SH 668049 937837 316.957 

PT230 SH 668097.9 937782.4 318.229   PT490 BLD 668043.9 937838 317.267 

PT231 SH 668097.4 937777.8 318.321   PT491 BLD 668073.7 937792 318.073 

PT232 SH 668097.1 937773.1 318.529   PT492 SH 668073.1 937784.7 318.318 

PT233 SH 668100.9 937773.3 318.58   PT493 BD 668073.2 937780.3 318.439 

PT234 SH 668102.2 937777.1 318.319   PT494 SH 668069.9 937784.4 318.355 

PT235 SH 668101.1 937781.3 318.285   PT495 SH 668064.9 937790.3 318.076 

PT236 SH 668100.2 937785.2 318.239   PT496 SH 668062.6 937784.4 318.262 

PT237 SH 668102.1 937788.4 318.071   PT497 SH 668061.5 937781.1 318.253 

PT238 BLD 668103.3 937790.4 317.873   PT498 SH 668054.5 937781.3 318.237 

PT239 SH 668105.1 937786.6 318.137   PT499 SH 668053 937785.2 318.171 

PT240 SH 668105.9 937783.1 318.189   PT500 SH 668051.4 937789.3 318.097 

PT241 SH 668106.2 937778.4 318.236   PT501 SH 668045 937791.3 318.148 

PT242 SH 668106.3 937774.5 318.368   PT502 SH 668044.7 937785.9 318.238 

PT243 SH 668106.4 937771.7 318.607   PT503 BD 668043.5 937789.4 318.204 

PT244 SH 668109.8 937771.4 318.611   PT504 BD 668046.8 937781.7 318.191 

PT245 SH 668114.7 937770.8 318.727   PT505 SH 668050.5 937781.3 318.192 

PT246 CV 668118.6 937769.6 318.768   PT506 BLD 668073.6 937768.4 318.52 

PT247 CV 668118.6 937769.2 318.875   PT507 SH 668072.8 937765.9 318.772 

PT248 BLD 668120.4 937768.5 318.906   PT508 SH 668068.1 937767.9 318.712 

PT249 SH 668118 937771.4 318.745   PT509 SH 668064.3 937765.9 318.846 

PT250 SH 668114.6 937774.6 318.45   PT510 SH 668061.8 937764.8 318.757 

PT251 SH 668112.3 937778.2 318.273   PT511 SH 668059.2 937766.6 318.779 

PT252 SH 668116.9 937781 318.219   PT512 SH 668056.8 937767.3 318.813 

PT253 SH 668114.7 937784 318.086   PT513 SH 668055.6 937765.9 317.208 

PT254 SH 668110.9 937786.4 318.028   PT514 SH 668054.7 937765.1 317.217 
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PT255 SH 668108.3 937788.8 318.063   PT515 SH 668050.4 937765 317.161 

PT256 SH 668106.5 937792.3 317.922   PT516 SH 668048.2 937766.1 317.281 

PT257 SH 668104.3 937794.3 317.593   PT517 SH 668047.6 937767.1 318.799 

PT258 SH 668106.6 937796.8 317.885   PT518 BLD 668043.7 937764.7 322.083 

PT259 SH 668110.6 937794.3 317.866             
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